
FINAL Dee®m™ ADDENDUM
MACIN+®SH VERSI®N

Welcome to Final DOOM™, Before playing, you'll need to read the Final DOOM manual and this addendum which contains
information for playing in Multiplayer mode, as well as installation, technical support, and troubleshooting instructions.

SYSTEM REQUIREMENTS
Final DOOM for the Macintosh® requires a Macintosh or Macintosh compatible computer with a minimum of a 68040,
68LC040, or PowerPC™ processors with 8 megabytes (MB) of RAM (at least 4500K of free RAM is required), and 20 MB of free
hard disk space for full installation. A monitor that supports 256 colors/grays with a minimum resolution of 640 x 400 pixels is

required. System 7.1 or later is required. An AppleTalk® network, either LocalTalk® or Ethernet, is required for network play
between Macintosh computers, and a network that uses the IPX/MacIPX™ protocol is required for network play between
Macintosh and PC-compatible computers. A modem that can be set to at least 9600 baud is required for modem play.

Final DOOM runs faster on Macintosh computers with faster processors, such as the PowerPC 601 or 604. To improve
DOOM'’s speed on your system, you can reduce the screen size, use Low Detail from the “Graphics Detail” item of the Control
menu, or run DOOM with fewer System Extensions and Control Panels enabled. You can also choose “Kill Finder” from the
Setup dialogs to minimize the effect of the System Software on DOOM’s performance (the Finder™ will automatically restart
when you quit DOOM). If you have purchased the CD/ROM version of Final DOOM, we suggest that you install it to your
hard disk drive before playing. Speed problems on marginal systems increase when running DOOM directly from your CD.

MACINT®SH GRAPHICS
The “full screen” size of DOOM for the Macintosh is 640 x 400, not 640 x 480, and may not fill your entire monitor. This reso-
lution was chosen in order to support both a number of PowerBook® screens as well as to remain compatible with the great
number of WAD files that are currently available for the IBM® PC. WADfiles can be downloaded from a number of on-line
services such as America Online, Compuserve, eWorld™, and others. If your monitor supports more than one screen resolu-
tion, we suggest that you select the 640 x 480 resolution. This will allow DOOM to fill more of your screen than if higher res-
olutions are selected. Use the Monitors Control Panel to select the resolution of each of your monitors. DOOM will display
itself on your “main” monitor if you have more than one monitor. The main monitor is the one with your menubar. To change
yourmain monitor, drag the little menubar to another monitor in the Monitors Control Panel and restart your Macintosh.

You can also select “Small Graphics” under the Options menu in order to make DOOM run faster on slower Macintosh mod-
els. A minimum of a 33Mhz 68040/68LC040 is recommended.

INSTALLING Do®m FROM 3.5” DISKS
DOOM is too large to run from a floppy disk, so before playing you must first install DOOM to your hard disk drive. To install
DOOM, follow these steps:

Make a backup copy of your original disks.
Put disk #1 in your disk drive. Once the disk is visible on your desktop, double-click the “Final DOOM Installer” icon.
Choose to install the options you need. QuickTime® 2.0, Sound Manager™ 3.1, MacIPX, Modem Tool, and Serial Tool are all
included on the distribution disks. You do not have to install all of these files if you already have current (or later) versions of
these System Extensions and Tools. The full installation requires that you have about 20 MB of free space on your hard disk
drive.
Click the “Install” button. The installation program will prompt you to insert additional disks from the original set as they are
needed. DOOM is installed as a “fat” application — that is, it can be run on either Power Macintosh™ or 68K-based Macintosh
computers.
We highly recommend that you restart your Macintosh before playing DOOM.

NOTE: Do not rename the DOOM.WAD file after it has been installed. DOOM looks for this file by name.

INSTALLING Doom FROM YOUR CD
Insert the Final DOOM CD disc into your CD drive. The disc’s icon should be displayed on your desktop after a few moments.
Double-click the disc’s icon to open it. Double-click the “Final DOOM Installer” icon. Choose to install the options you need.
QuickTime® 2.0, Sound Manager™ 3.1, MacIPX, Modem Tool, and Serial Tool are all included on the distribution disks. You
do not have to install all of these files if you already have current (or later) versions of these System Extensions and Tools.
The full installation requires that you have about 20 MB of free space on your hard disk drive. Click the “Install” button.
The installation program will prompt you to insert additional disks from the original set as they are needed. DOOMis installed



as a “fat” application — that is, it can be run on either Power Macintosh™ or 68K-based Macintosh computers. We highly rec-
ommend that you restart your Macintosh before playing DOOM.

Note: Do not rename the DOOM.WAD file after it has been installed. DOOM looks for this file by name. To play from the
hard drive’s DOOM.WAD file, you may simply delete the DOOM.WAD file from your hard drive or temporarily rename it.
RUNNING DO®®m DIRECTLY FROM THE CD
You can also quickly install DOOM by merely dragging the “DOOM” icon onto your hard disk drive. This will allow you to
play the game directly from the CD, although it will be slower than playing from your hard disk drive.

You may also selectively install different portions of the program and its related files. You could install the music files on your
hard disk drive, but leave the WAD file on the CD, or vice versa. If you are playing with music turned on, we suggest that you
move the folder named “Music” to your hard disk drive.

ABOUT SYSTEM EXTENSIONS
System Extensions provide functionality not normally built into your system. Some System Extensions will impact the speed of
your Macintosh, and therefore, the speed of DOOM. You should disable all Extensions and Control Panels that are not needed
while playing DOOM. A number of extensions, including RAM Doubler, AppleTalk, File Sharing Extension, and SpaceSaver,
will have a profound impact on the performance of DOOM and should therefore be disabled prior to playing DOOM.

To disable System Extensions and Control Panels, do the following:
Macintosh System 7.5 or later: Open the folder named “Control Panels” with the System Folder of your startup disk drive.
Double-click the “Extensions Manager” icon. (You may be able to select “Control Panels” and then “Extensions Manager”
through the Apple menu.) Each Extension and Control Panel will be listed and can be toggled on or off by clicking on the
name of the extension. A check mark indicates that the Extension/Control Panel is currently enabled. After turning off unnec-
essary Extensions/Control Panels, close the Extensions Manager window and restart your Macintosh.

Macintosh System 7.1 or later: Create a folder within your System Folder named “Extensions (disabled)” and one named
“Control Panels (disabled)”. Drag the unnecessary Extensions and Control Panels into the respective folders and restart your
Macintosh.

EXTENSIONS YOU NEED
We suggest that you disable all Extensions and Control Panels except QuickTime (for music support), QuickTime PowerPlug
(Power Macintosh only), QuickTime Musical Instruments, Sound, Sound Manager, Memory, Keyboard, General Controls and
any “Tune-Up” extensions currently supported by Apple® Computer, Inc. A Tune-Up Extension called “Apple Multimedia
Tuner” is available for those running QuickTime 2.0 and Sound Manager 3.0. It fixes a number of problems on various
Macintosh models and is included with the Final DOOM. You should also not disable anything called “Finder Update” or
“System Update”, or enabler Extensions, such as “PPC 601 Enabler”. If you are playing DOOM from the CD, you will need to
enable the Apple CD-ROM extension, although you will not need Foreign File Access™ .

Some system versions, including System 7.5, have Sound Manager 3.0 built in and will not require the Sound Manager
Extension. You may also have a later version of QuickTime or Sound Manager than is included in the distribution CD/disks.
Before replacing any of your System Software, you should first try running DOOM. If the needed version is not available, you
will be informed via a dialog that a certain version is required.

Power Macintosh owners should note that Sound Manager 3.1 — included with both the CD and disk versions of DOOM - is
the first “native” version of the Sound Manager and dramatically increases the speed of sound performance. Make sure you are
running this version (or later) for maximum performance.

MULTIPLAYER ADDENDUM

GETTING STARTED
To start a multiplayer game, launch the Final DOOM application while holding down the letter ‘M’ key. This will open the
Multiplayer Setup dialog which allows you to configure a multiplayer game.

NUMBER OF PLAYERS: A maximum of four players can play multiplayer DOOM on a network. A maximum of two players
can play multiplayer DOOM via a serial or modem connection.

VERY IMPORTANT: Modem play is implemented through Apple’s Communication Toolbox (CTB). We have enclosed a tool
called “Apple Modem
Tool” which may or may not work with your modem. Some modems come with a CTB tool. If so, use the tool that came with
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your modem, or contact your modem manufacturer to obtain a CTB tool for use with your particular model. Also note that the
suggested settings are 9600 baud, with error-correction and data-compression turned off (especially modem connections with
PC users). A

You may also find it possible to use other types of CTB connection tools in order to play DOOM. A number of third party 1

vendors sell various tools to support such protocols as TCP/IP (Internet connections).

MULTIPLAYER GAMES OVER A NETWORK (IPX/MacIPX): You must be connected to an IPX network and have MacIPX
installed in your system to play in IPX multiplayer mode. Before launching DOOM, open the MacIPX Control Panel and select
a MacIPX interface. If you are using the Ethernet interface, double-click on the Ethernet icon to select the frame type. You
must use the same frame type on all machines. Ethernet 802.3 is what most PCs will be using. You should turn off the “Always |
Auto-Configure Frame Type” option.

To run an IPX network game, select “IPX” from the “Connect via:” pop-up menu in the Multiplayer Setup dialog. Then enter
the number of players. More than one group of players can play a multiplayer game on the same IPX network by using a dif-
ferent network socket number. Valid network socket values are 0 (default) through 64000. Make sure that each player in yours
game has entered the same value in the “Network Socket” box. Press the “Start Game” button to begin play.

Note: The version of MacIPX included with Final DOOM is not currently compatible with Open Transport, the networking
software built into the Power Macintosh 7500, 8500, and 9500. If you are running version 7.5.2 or later of the Mac OS, you are
probably running Open Transport and cannot use the enclosed MacIPX software.

MULTIPLAYER GAMES OVER APPLETALK: To run an AppleTalk network game, select “AppleTalk” from the “Connect via:”
pop-up menu in “The Final DOOM Multiplayer Setup” dialog. Then enter the number of players (2-4). If more than one group
of players attempt to start a game at the same time, the order of grouping will depend on when each player started their
game. Wait a few moments before starting another group of players.

MULTIPLAYER GAMES USING THE SERIAL PORT: To run a multiplayer game using the serial port, select either “Serial
(Modem)” or “Serial (Printer)” from the “Connect via:” pop-up menu in the Multiplayer Setup dialog.

~ MULTIPLAYER GAMES USING THE COMMUNICATIONS TOOLBOX: To run a multiplayer game using the Communications io
toolbox, select “Comm Toolbox” from the “Connect via:” pop-up menu in the Multiplayer Setup dialog. If you will be using a
tool which requires initialization (such as the Apple Modem Tool) then one player (the one making the call) must check the
“Initiate Connection” checkbox. After pressing the “Start Game” button, the Connection Settings dialog will open. You can then
select the CTB Tool you wish to use, and configure the connection (such as entering a phone number, or selecting “Wait for
Call”). Make sure that both players are using the same configuration. Turn off error-correction and data-compression.

MULTIPLAYER INSTRUCTI®NS
Many of the rules for playing DOOM change for the multiplayer game. Read the following information carefully before you
begin to play DOOM in multiplayer mode.

MENUS: When you activate the Options menu or submenus via the <Escape> key, the game KEEPS RUNNING so that other
players can continue with the action. So it is best to find a safe place before adjusting screen sizes or sound volumes. Note
that on the Macintosh if you hold down a menu bar or customize your key commands it will STOP all players (the game will
appear “locked”, though the mouse can be moved and menus selected). Consider other players when making changes.

UNPAUSE: A player may PAUSE the game by pressing Command-P or selecting “Pause” from the Control menu, but any other
player can UNPAUSE the game by selecting “Pause” again. Make sure it’s OK with your buddies before taking a breather.

;

SAVE: When you save a multiplayer game, DOOM prompts everyone to name the file (or select a slot if playing on a PC).
Before saving the game with PC users, everyone should agree on a safe save game slot.

LOAD: You cannot load a saved game while playing a multiplayer game. To load a game, everyone must quit from the current
game and restart the game from the saved game. To start a game from a saved game, you can double-click the saved game

1

file from the Finder, or drag the saved game’s file on top of the DOOM application icon to relaunch DOOM. Then use the ¥
Multiplayer Setup dialog to begin play. PC users can select the game from the SETUP program or identify it as a command line
parameter.

WEAPONS: When a player runs over a weapon, he picks it up, but the weapon remains in the game for other players to take.
By selecting “AltDeathMatch” in the Multiplayer Setup dialog, weapons you pick up will disappear but will reappear later dur-



ing the game during DeathMatch play. Note: Shotguns dropped by former human sergeants are removed from the game after
being picked up or smashed.

DEATH: If you die and restart in the level, previously taken items and destroyed monsters DON'T reappear. Even though
you've died, other players have survived. We didn’t want to undo all of their fine destruction by reviving every monster in the
area. This also means the level will eventually run dry of monsters and ammunition. You can avoid this by selecting the
Nightmare skill level — monsters that will respawn after they've been smacked down. You can also enable the “Respawn
Monsters” option in the Multiplayer Setup dialog to force DOOM to revive destroyed monsters in any difficulty level.

TELEPORTERS: When a player enters a teleporter, anything that is standing on his or her destination teleporter will be
destroyed. This is called telefragging. This humiliating form of death is second in shame only to being bludgeoned by your
opponents knuckles. It can be avoided by getting off the teleporter as quickly as possible.

UNIFORM COLORS: In multiplayer games, each player's uniform is a different color. The color of your character is the color
behind your face on the status bar. The colors are BROWN, INDIGO (black), GREEN, and RED.

CHAT MODE: In a multiplayer game you can communicate with other players in the Chat mode. To enter Chat mode and
broadcast a message to all the players, press the letter “T°. A cursor will appear in the top left corner of the screen. Type your
message and press the <Return> key to send it. To broadcast to a specific player, instead of pressing “I” you'll need to press
the Option key and the first letter of the player’s color, (B)rown, (Dndigo, (G)reen, or (R)ed.

CHAT MACROS: In a multiplayer game, you can send your own pre-defined macros by initiating Chat mode (as stated above),
then holding down the Option key and pressing the number key that corresponds to the macro you wish to send. For exam-
ple, if macros #2 is “Eat it and die!”, initiate Chat mode by pressing ‘I’, then hold down Option and press 2. Chat macros can
be customized by selecting the “Edit Chat Macros” item in the Control menu.

EXITING A LEVEL: When one player exits a level, all players instantly exit with him, regardless of their position or their status.

COOPERATIVE OR DEATHMATCH MODE
There are two ways to play multiplayer: Cooperative or DeathMatch. In Cooperative mode the players work together. In
DeathMatch mode your mission is to kill everything that moves, including your buddies. You can choose which mode you
wish to play in the Multiplayer Setup dialog. The differences between the Cooperative and DeathMatch mode are as follows:

WHERE YOU START: In Cooperative mode each player begins in the same area. In DeathMatch mode the players begin in
completely different areas — if you want to see your buddy you'll need to hunt him down. And to make the hunt more inter-
esting, each time you die you'll restart in one of several random locations.

KEYS: In DeathMatch mode the players start each location with the keys necessary for opening any locked door in that area.

STATUS BAR: In DeathMatch mode the ARMS section on the status bar is replaced with FRAG, indicating the number of times
you've killed your opponents.

AUTOMAP: In Cooperative mode the Automap works the same way it does in single-player mode. Each player is represented
by a different color arrow. In DeathMatch mode you won't receive the pleasure of seeing your opponents on the map. Just
like the monsters, your friends could be just around the corner, and you won’t know until you face them.

SPY MODE: If you're playing in Cooperative mode, press F12 or Command-2 to toggle through the other player's viewpoint(s).
You still retain your own status bar at the bottom, and if your view reddens from pain, it is YOU, not your partner who has
been hit.

COOPERATIVE OR DEATHMATCH MODE: When playing DeathMatch, you may think it is preferable to kill yourself rather
than having your opponent kill you and gain a frag. Think again! DOOM takes a frag from your total when you take the easy
way out.
Tip: Don’t get too close to your opponent when shooting him with a missile launcher.

INTERMISSION SCREENS: In both Cooperative and DeathMatch modes the intermission screen tallies your achievements. In
Cooperative mode the intermission screen lists the achievements for all players in the game. In DeathMatch mode the intermis-
sion provides a death count for everyone, letting you know who killed whom.



DEATHMATCH MO®DE GAMEPLAY NOTES
The rules for completing or winning a DeathMatch game have been intentionally left general. Any player can exit an area and
force all players to move to the next area. Also, there is no limit on how many kills are required to declare a player the win-
ner. We decided to leave this up to you.

TROUBLESHOOTING :

When DOOM runs, I get an “Insufficient memory” error or DOOM just doesn’t run.
You don’t have enough free RAM to run DOOM. Try allocating more memory for DOOM by selecting the Final DOOM icon
(click on it ONCE), then select “Get Info” from the File menu while in the Finder. Increase the number listed as the “Preferred
Size’:

DOOM runs really slow, or locks or “pauses” on a fast system (such as a PowerPC-based Macintosh).
Refer to the section above about disabling System Extensions and Control Panels that are not required in order to run DOOM.
Turn off all unnecessary Extensions and Control Panels. Also, you can select “Kill Finder” in the single and multiplayer Setup
dialogs. If you are running from a CD, copy the DOOM.WAD file and the Music folder to your hard disk drive and eject the
€D.

All PowerPC chips are not created equal. The PowerPC 601, for instance, is much faster than the 603, and the 603e is much
faster than the 603. To increase playing speed, reduce the screen size, or change to the Low Resolution by using the “Graphic
Detail” item in the Control menu. PowerPC-based Macintosh users should ensure they are running Sound Manager 3.1 or later.

One player may be accessing a menu or the keyboard options screen, which cause all other players in multiplayer mode to
wait until the operation is complete. Frag the player responsible to show your disapproval.

The function keys don’t seem to work as advertised.
Some System Extensions (such as QuicKeys from CE Software) will “remap” the function keys to other uses. Disable these
extensions while playing DOOM, or temporarily turn them off.

The Music sounds horrible, but I have QuickTime 2.0 loaded.
Ensure that you have a file called “QuickTime™ Musical Instruments” installed in your Extensions folder. That folder is located
in your System Folder of your startup hard disk drive. If not, copy it from the CD (or reinstall from disk, selecting QuickTime
installation) into the Extensions folder. Thatfile is located in the System Software folder, in the QuickTime folder on the CD
version of Final DOOM.

Music is slower on the Macintosh than it is on the IBM® PC.
QuickTime is used to play the music in DOOM (it’s software), and is not as fast as the MIDI-compatible sound cards (hard-
ware) that are common on most IBM PCs. Thus, it has to share the processor time with DOOM. Turn the music off by select-
ing the “Music” menu item from the Options menu, or disable the QuickTime Extension altogether. Some versions of
QuickTime may support external MIDI devices (such as a MIDI keyboard) for music output.

I can’t hear any music or sound effects even after changing the Sound and Music volumes using the DOOM menu.
Check your master volume controls in the Sound Control Panel. The volume controls in DOOM change the DOOM output to
the range defined by the Macintosh’s sound output volume setting.

I've tried everything and still there’s no music.
Select a lower Sound Output rate in the Sound Control Panel, such as 11kHz. If you still don’t hear any music, reduce the
amount of memory allocated to Final DOOM (Get Info in the Finder, adjust Preferred Size setting). Make sure all unnecessary
Extensions and Control Panels are turned off. Select “Kill Finder” in the Single-Player or Multiplayer Setup dialog.

I've received the message “Consistency Failure” while running DOOM in multiplayer mode.
For DOOM to run properly as a multiplayer game, all of the machines that are running DOOM must maintain a nearly identi-
cal status of the game during network play. If you receive this message, something has occurred which caused the multiplayer
game on one computer to be different from the multiplayer games running on the other systems. If this occurs, all of the play-
ers must quit from DOOM and restart the game.
Note: “Noisy” phone connections when playing over the modem can cause this to occur.

I've received the message, “Different versions of DOOM cannot play a network game”.
To improve DOOM, id Software updates it when necessary. You cannot play a multiplayer game with someone who is using a
different version of DOOM. The Macintosh version number is not identical with the overall DOOM version number. Version
1.0 and 1.0.2 for the Macintosh support DOOM Version 1.9 for the PC. Any updates of the Macintosh version will specify the



PC version needed. Updates (“patches”) can be found on on-line services or on the Internet.

Why can’t I get DOOM to run as a multiplayer game over IPX/MacIPX?
If someone else is using DOOM in Multiplayer mode over an IPX network you may receive a network port conflict. From the
Multiplayer Setup dialog, change DOOM to run under a different port. Consult with the person in charge of your network to
receive a valid port address. You must also ensure that you are using a compatible version of IPX (most PCs use Ethernet
802.3, which can be specified in the MacIPX Control Panel). Also, make sure you have the “Always Auto-Configure Frame
Type” option turned off.

Why isn’t the motion smooth?
If the animation isn’t running smoothly on your system, try reducing the screen size and/or play DOOM in LOW resolution
mode. Also ensure that you have disabled any unnecessary Control Panels or System Extensions. Refer to your DOOM manual
or this addendum for instructions on these options.

DOOM reads data in from the WAD file as it is needed (hard drives are faster than CD drives, RAM is faster than hard drives).
If you have enough memory, create a RAM disk using the Memory Control Panel and copy your WAD file onto the disk image
(it will show up on your desktop). Double-click the copy of the WAD file on your RAM disk to launch DOOM and use the
RAM disk copy. The DOOM.WAD file is about 12 MB, so you will need a LOT of RAM to make use of this option (reduce
~DOOM’s memory requirement to 4000K while using a RAM disk).

m tired of looking at the company logos at startup.
Press the <Escape> key or click the mouse button to skip the logos and begin a single player game, or press ‘S’ to access the
ingle-Player Setup dialog, or ‘M’ to access the Multiplayer Setup dialog.

can't see the mouse or access the menubar.
ess Command-K to return to Keyboard mode (mouse enabled for the menubar). To enable the mouse for control of move-
t within DOOM, press Command-M (or Command-] for Joystick).

'ECHNICAL SUPPOR*
Ifyou experience problems running or playing DOOM, you can use any of the following avenues to obtain assistance:

Assistance Via World Wide Web
et up-to-the-minute technical information at the GT Interactive Software web-site, at http://www.gtinteractive.com, 24 hours a

day, seven days a week.
In the Support section you'll have access to our FAQ documents, (Frequently Asked Questions) which contains our latest trou-
bleshooting information. You can also visit our Forums area, where you can swap email with other gamers, our FTP (File
Transfer Protocol) area where you can download patches and new enhancements as soon as they become available, our
Hints/Cheat Codes area, and other areas where you can get valuable information on GT Interactive Software products.

HELP VIA TELEPHONE
For phone assistance, call GT Interactive Software’s Tech Support at 970-522-1797. We have an Interactive Voice Response and
Faxback system that is available 24 hours a day, seven days a week. If you should need live support, we are available Monday
through Friday, 8 AM until Midnight (EST). Please note that live Tech Support may be closed on all major holidays. We ask
that you do the following when calling: be at your computer; have your system information ready for our technicians includ-
ing system make and model; RAM; video and sound card data and drivers; and any screen or error messages you've encoun-

tered and where (if not currently displayed on your screen). It will expedite your handling significantly.

HELP VIA MAIL
In the event our technicians determine that you will need to forward materials directly to us, please include a brief letter
explaining what is enclosed and why. Please send us the CD, and manual ONLY. Make sure you include your telephone
number in case we need to call you. Your mail should be sent to the following address:

GT Interactive Software, Attn: TS/QA
1 Nixon Lane, Edison, NJ 08817

Please do not make copies The program you've purchased was produced through the efforts of many people. Don’t make
copies for others who have not paid for the right to use the product. To report copyright violations to the Software Publishers
Association, call 1-800-388-PIR8 or write:

Software Publishers Association
1101 Connecticut Ave., Suite 901, NW Washington, DC 20036

This program is protected by federal and international copyright.
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